
  

 

 
 
 
 
 

 

 

 

U.S. DEPARTMENT OF COMMERCE 
National Oceanic and Atmospheric Administration 
National Marine Fisheries Service 
Pacific Islands Fisheries Science Center 
NOAA Technical Memorandum NMFS-PIFSC-149 
https://doi.org/10.25923/c64k-gh75 

September 2023 

Quantifying Corallivory from  
Structure-from-Motion Models 
Daniela Escontrela Dieguez, Roseanna Lee, Tye L. Kindinger, Courtney S. Couch, Jonathan 

Charendoff  

 
 
 
 
 
 

https://doi.org/10.25923/c64k-gh75


 ii 

Quantifying Corallivory from  
Structure-from-Motion Models 
Daniela Escontrela Dieguez1, Roseanna Lee2,3, Tye L. Kindinger3, Courtney S. Couch2,3, 

Jonathan Charendoff2,3 

1University of Hawaiʻi at Mānoa 
Department of Biology 
Edmondson Hall 418 
2538 McCarthy Mall 
Honolulu, HI 96822 

2Cooperative Institute for Marine and Atmospheric Research, University of Hawaiʻi at 
Mānoa, Honolulu, HI, USA 

3Pacific Islands Fisheries Science Center 
National Marine Fisheries Service 
1845 Wasp Boulevard 
Honolulu, HI 96818 

NOAA Technical Memorandum NMFS-PIFSC-149 
September 2023 

 

U.S. Department of Commerce 
Gina Raimondo, Secretary 

National Oceanic and Atmospheric Administration 
Richard W. Spinrad, Ph.D., NOAA Administrator 

National Marine Fisheries Service 
Janet Coit, Assistant Administrator for Fisheries  

About this report 
The Pacific Islands Fisheries Science Center of NOAA’s National Marine Fisheries Service uses 
the NOAA Technical Memorandum NMFS-PIFSC series to disseminate scientific and technical 
information that has been scientifically reviewed and edited. Documents within this series reflect 
sound professional work and may be referenced in the formal scientific and technical literature. 



 iii 

Recommended citation 
Escontrela Dieguez D, Lee R, Kindinger TL, Couch CS, Charendoff J. 2023. Quantifying 
corallivory from Structure-from-motion models. U.S. Dept. of Commerce, NOAA Technical 
Memorandum NMFS-PIFSC-149, 8182 p. doi: 10.25923/c64k-gh75 

Copies of this report are available from 
Pacific Islands Fisheries Science Center 
National Marine Fisheries Service 
National Oceanic and Atmospheric Administration  
1845 Wasp Boulevard, Building #176 
Honolulu, Hawaii 96818 

Or online at 
https://repository.library.noaa.gov/ 

  

https://repository.library.noaa.gov/


 iv 

Table of Contents 
List of Tables .................................................................................................................................. v 

List of Figures ................................................................................................................................ vi 
Abstract ........................................................................................................................................... 1 

1. Introduction ................................................................................................................................. 2 

2. Materials needed ......................................................................................................................... 4 

3. Model generation ........................................................................................................................ 5 

3.1 Image Collection ................................................................................................................... 5 

3.2 Data Management and Quality Control ................................................................................ 6 

3.3 Generating 3D Models and 2D Orthomosaics ...................................................................... 6 

4. Setting up ArcGIS Pro for Model Annotation ............................................................................ 7 

4.1 Creating the Geodatabase ...................................................................................................... 7 

4.2 Importing 2D Orthomosaics into ArcGIS Pro .................................................................... 16 

4.3 Adding Transects and Quadrats to an Orthomosaic in ArcGIS Pro .................................... 21 

4.4 Adding Geodatabase to ArcGIS Pro Projects ..................................................................... 27 

5. Extracting Corallivory Data Using ArcGIS Pro ....................................................................... 29 

5.1 Extracting Coral Area by Species ....................................................................................... 29 

5.2 Annotating Fish Predation ................................................................................................... 29 

5.2.1 Getting ready to annotate .............................................................................................. 30 

5.2.2 Annotating fish predation ............................................................................................. 33 

5.3 Annotating Sea Star and Drupella Predation ...................................................................... 38 

5.4 Extracting Data from ArcGIS Pro ....................................................................................... 39 

6. Literature Cited ......................................................................................................................... 40 

7. Appendix ................................................................................................................................... 43 

Appendix 1. Corallivory Annotation Descriptions (Hawaiʻi) ................................................... 43 

Coral species .......................................................................................................................... 43 

Corallivory categories ............................................................................................................ 50 

Bite mark condition ............................................................................................................... 60 

Overlap scores ....................................................................................................................... 63 

Appendix 2. Extracting orthoblocks.......................................................................................... 66 

  



 v 

List of Tables 
Table 1. Column name and type along with field type information to complete steps 14 and 15. 
For columns without drop-down options, leave the ‘Field Domain’ blank. For columns with 
drop-down options, fill in the ‘Field Domain’ with the column name. ........................................ 16 
 



 vi 

List of Figures 
Figure 1. A spray-painted fishing weight is used to mark where quadrats will be drawn in ArcGIS Pro. ... 5 
Figure 2. Excel table of GDB domains. Once imported into ArcGIS Pro, columns C, E, F, G, and I will 
have corresponding drop-down options. Columns A, B, D, H, J, and K will need to be manually filled in 
using ArcGIS Pro. ......................................................................................................................................... 8 
Figure 3. Open an ArcGIS Pro file. (1) Under the ‘Analysis’ tab, select ‘Tools’. (2) On the right side of 
the screen, search for and select ‘Create File Geodatabase’. ........................................................................ 9 
Figure 4. Fill in the parameters in the ‘Create File Geodatabase’ and select ‘Run.’ .................................. 10 
Figure 5. (1) Under the ‘Analysis’ tab, select ‘Tools’. (2) On the right side of the screen, search for and 
select ‘Table to Domain’. ............................................................................................................................ 11 
Figure 6. Fill in the parameters in the ‘Table to Domain’ window as follows and select ‘Run’. ............... 12 
Figure 7. (1) Under the ‘Analysis’ tab, select ‘Tools’. (2) On the right side of the screen, search for and 
select ‘Create Feature Class’. ...................................................................................................................... 13 
Figure 8. Fill in the parameters in the ‘Create Feature Class’ window as follows and select ‘Run’. ......... 13 
Figure 9. (1) Under the ‘Analysis’ tab select, ‘Tools’. (2) On the right side of the screen, search for and 
select ‘Add Field’. ....................................................................................................................................... 14 
Figure 10. Fill in the parameters in the ‘Add Field’ window as follows and select ‘Run’ for columns (A) 
without drop-down options and (B) with drop-down options. The ‘Field Type’ will vary depending on the 
input values or drop down options (Table 1). ‘Field Domain’ should remain blank for columns without 
drop down options and it should match the ‘Field Name’ for columns with drop down options. .............. 15 
Figure 11. Open ArcGIS Pro and select the ‘Map’ icon (boxed in red). .................................................... 16 
Figure 12. Screenshot of the pop-up window that appears after the ‘Map’ option is selected along with 
how to complete it. ...................................................................................................................................... 17 
Figure 13. Removing the ʻWorld Topographic Map’. ................................................................................ 17 
Figure 14. Use the ‘Add Folder’ option to add the folder to the document. ............................................... 17 
Figure 15. Use the ‘Add Data’ option (boxed in red) to import the orthomosaic. The error message can be 
seen on the upper right hand corner in the blue box. .................................................................................. 18 
Figure 16. Use the ‘Zoom to Layer’ option on the left side of the screen if the model is not visible. ........ 18 
Figure 17. (A) Go to the ‘Tools’ section under the ‘Analysis’ tab (boxed in red). On the right side of the 
screen, search for and select ‘Define Projection’. (B) Fill in the parameters as described above. ............. 19 
Figure 18. (1) Select the ‘Raster Layer’ tab, then (2) then navigate to ‘Stretch Type’ and select ‘None’ to 
color correct the model. .............................................................................................................................. 20 
Figure 19. Use the ’Measure’ tool (boxed in red and under the ‘Map’ tab) to measure an object in the 
model to ensure it is correctly scaled. In the figure above, the scale bar was measured and has a length of 
0.5 meters. Note:scale bars may be different lengths. Become familiar ahead of time with the scale bar(s) 
used for proper scaling and orientation. This project used both 0.25 and 0.5 meter scale bars (target to 
target). ......................................................................................................................................................... 20 
Figure 20. Click the ‘Catalog Pane’ option (boxed in red) under the ‘View’ tab. A ‘Catalog’ window will 
appear. Drag and drop to the right of the screen to pin it into place. .......................................................... 21 
Figure 21. (A) Right click on the ‘ARC’ folder in the Catalog and select ‘New’ → ‘Shapefile’. (B) Fill in 
the ‘Creature Feature Class’ fields as previously described. ...................................................................... 22 
Figure 22. (1) In the ‘Edit’ tab, first select ‘Edit’ and (2) then click on ‘Create.’ ...................................... 22 



 vii 

Figure 23. (A) First make sure the ‘line’ option is selected in the ‘Create Features’ pane on the right side 
of the screen. (B) Change the type of line by (1) double clicking on the line under the transect name on 
the left side of the screen and (2) clicking the ‘Highway’ option on the right side of the screen. .............. 23 
Figure 24. Turn on the ‘Dynamic Constraints’ option at the bottom of the screen (boxed in red). ............ 23 
Figure 25. For each transect line, click at the pink weight, follow the transect line for 3.28 ft (1 m) and 
double click to fix the line into place. ......................................................................................................... 24 
Figure 26. Once all the 1-m segments have been drawn, zoom out to ensure seven are visible. (1) Go to 
the ‘Edit’ tab and hit ‘Save.’ (2) Lastly, go to the ‘Map’ tab and select ‘Explore.’ .................................... 24 
Figure 27. Right click on the transect layer on the left side of the screen then press ‘Selection’ and ‘Select 
All’ from the drop down menus. ................................................................................................................. 25 
Figure 28. Select the ‘Buffer’ option (boxed in red) in the ‘Analysis’ tab. Then fill in the ‘Buffer’ pain on 
the right side of the screen as previously described. ................................................................................... 26 
Figure 29. After step 11, quadrats will be drawn around the transect lines. To fix the shading and outline, 
(1) double click on the site#_segments layer on the left side of the screen and (2) select the ‘Black 
Outline’ option on the right. ........................................................................................................................ 26 
Figure 30. With the model open in ArcGIS Pro, (1) navigate to the ‘Insert’ tab and (2) select ‘Add 
Folder’. ........................................................................................................................................................ 27 
Figure 31. After navigating to the Geodatabase in the Catalog, (A) (1) click on the arrow to the left of the 
Geodatabase name, (2) right click ‘template’ and (3) select ‘Copy.’ (B) Go back to the Geodatabase, (1) 
right click and (2) select ‘Paste.’ ................................................................................................................. 28 
Figure 32. When project is open, zoom into the quadrat and turn the check mark on for the multipoint 
feature on the left side of the screen (boxed in red). ................................................................................... 30 
Figure 33. Select the ‘Edit’ option under the ‘Edit’ tab. ............................................................................. 30 
Figure 34. (A) Click on the right pointing arrow next to the feature name on the right side of the screen 
(boxed in red). (B) Fill in the ‘SITE’ and ‘ANNOTATOR’ fields as described above and optionally the 
rest of the fields for each new annotation combination. ............................................................................. 31 
Figure 35. Turn on the multipoint annotation tool by clicking on the icon boxed in red. .......................... 32 
Figure 36. Right click on the name of the multipoint feature on the left side of the screen and select 
‘Attribute table’. .......................................................................................................................................... 32 
Figure 37. To turn on the cameras, select ‘cams’ on the right side of the screen (boxed in red). The small 
‘ON’ will appear once ‘cams’ has been clicked. Then select ‘none’ on the bottom left of the screen (boxed 
in blue). ....................................................................................................................................................... 33 
Figure 38. Drop a point (Point A) on the first coral along the search pattern. ............................................ 34 
Figure 39. Create a new row in the attribute table for each new combination of coral species, bite 
category, and condition in each quadrat. Then fill in the information in each column as described above.
 .................................................................................................................................................................... 36 
Figure 40. To view a new colony, drag the green point to the desired spot and select ‘snap’ (boxed in 
blue). Alternately, if the new underlying imagery isn’t showing up correctly, delete the point (boxed in 
red) and drop a new point. .......................................................................................................................... 36 
Figure 41. (A) Once all rows have been selected, right click on the ‘number_bites’ column and select 
‘Calculate Geometry,’ (B) fill in the pop up window as shown. ................................................................ 37 
Figure 42. (A) Colony-level and (B) close up images of Pocillopora damicornis. .................................... 43 
Figure 43. (A) Colony-level and (B) close up images of Pocillopora meandrina. ..................................... 44 



 viii 

Pocillopora grandis (uncommon, PGRA)—this is the largest of the Pocillopora species, and its size is one 
of the main defining characteristics, sometimes reaching a few feet in height. The branches are tubular 
and upright, sometimes flattened and forked at the tips. Smaller individuals may look similar to P. 
meandrina but P. grandis has larger spaces between the branches and branches typically don’t have the 
“c” shape (Figure 44).Figure 44. A) Colony-level (Photo by Erik Brush) and (B) close up images of 
Pocillopora grandis. ................................................................................................................................... 44 
Figure 45. (A) Colony-level and (B) close up images of Montipora capitata. ........................................... 45 
Figure 46. (A) Colony-level and (B) close up images of Montipora patula. .............................................. 45 
Figure 47. (A) Colony-level and (B) close up images of Montipora flabellata. ......................................... 46 
Figure 48. (A) Colony-level (Photo by Keoki Stender) and (B) close up images of Porites compressa. .. 46 
Figure 49. (A) Colony-level (Photo by Keoki Stender) and (B) close up images of Porites lobata. ......... 47 
Figure 50. (A) Colony-level and (B) close up images of Porites evermanni (Photos by Keoki Stender). . 47 
Figure 51. (A) Colony-level and (B) close up images of Pavona duerdeni. ............................................... 48 
Figure 52. (A) Colony-level and (B) close up images of Pavona varians. ................................................. 48 
Figure 53. (A) Colony-level and (B) close up images of Lobactis scutaria. .............................................. 49 
Figure 54. (A) Colony-level and (B) close up images of Cyphastrea ocelina. ........................................... 49 
Figure 55. (A) Colony-level and (B) close up images of Leptastrea bewickensis (Photo by Keoki Stender).
 .................................................................................................................................................................... 50 
Figure 56. (A) Colony-level and (B) close up images of Leptastrea transversa. ....................................... 50 
Figure 57. (A) Shortbodied blenny, (B) close up of a blenny bite mark, high density and overlapping 
blenny bite marks on (C) massive Porites and (D) M. capitata. ................................................................. 52 
Figure 58. (A) Crown-of-thorns, (B) cushion star, (C) massive Porites consumed by a crown-of-thorns 
sea star (Photo by NOAA), and (D) a juvenile Pocillopora consumed by a cushion star. ......................... 54 
Figure 59. (A) Drupella snail and Drupella predation on (B) Porites compressa, (C) Montipora capitata, 
and (D) Pocillopora damicornis. ................................................................................................................ 55 
Figure 60. (A) Parrotfish (Photo by Reef Guide), (B) close up of a parrotfish bite mark, (C) high density 
of overlapping parrotfish bite marks on massive Porites, and (D) a parrotfish bite mark on Montipora 
patula. ......................................................................................................................................................... 56 
Figure 61. (A) Barred filefish (Photo by Reef Life Survey) and (B) spotted pufferfish (Photo by 
Wikipedia Commons). Excavator bite marks on Porites compressa, (C) new and (D) healing. Examples 
of excavator bite marks on (E) Montipora capitata, (F) Pocillopora meandrina and (G) massive Porites.
 .................................................................................................................................................................... 58 
Figure 62. (A) Scattered scraper bite marks on the branches of Pocillopora meandrina. (B) Different 
conditions of scraper bite marks on Pocillopora meandrina (blue box is a healing scraper mark with a 
light tip and some verrucose missing, green box is a new scraper bite mark, and red box is not a bite mark 
as it is a light branch tip without missing verrucose). Scraper bite marks on (C) Porites compressa and 
(D) Montipora patula. ................................................................................................................................. 60 
Figure 63. Examples of new bite marks across different bite mark categories and coral species. (A) 
Excavator on massive Porites, (B) scraper on Montipora patula, (C) Drupella on Porites compressa, (and 
D) sea star on Pocillopora meandrina. ....................................................................................................... 61 
Figure 64. Examples of healing bite marks across different bite mark categories and coral species. (A) 
Excavator on Porites compressa, (B) scraper on Pocillopora meandrina, (C) blenny bites on massive 
Porites, and (D) parrotfish on massive Porites. .......................................................................................... 62 



 ix 

Figure 65. Examples of old bite marks across different bite mark categories and coral species. (A) An 
excavator bite wound on Porites compressa and (B) Drupella bite wound on Montipora capitata. ......... 63 
Figure 66. Examples of different overlap scores for (A-D) SCSP, (E-H) EXBR, and (I-L) SCRAP bite 
mark categories. Numbers on the bottom left corner of each image represent the overlap score. .............. 65 
Figure 67. (1) Double click on the current orthomosaic, then right click and (2) deselect the ‘Set as 
Default’ option. ........................................................................................................................................... 66 
Figure 68. On the left contents pane, deselect the multipoint tool, transect lines, and orthomosaic tiff; 
leave only the quadrat outlines selected. ..................................................................................................... 67 
Figure 69. (A) (1) Go to the ‘Map’ tab, (2) select ‘Add Data,’ (3) navigate to the high resolution ortho, 
and (4) select ‘OK.’ (B) Once uploaded, the high resolution tiff will appear in the navigation pane. ....... 68 
Figure 70. (1) From the ‘Analysis’ tab, (2) select ‘Tools.’ Search for and select ‘Define Projection’ (not 
pictured). (3) In the ‘Define Projection’ pane, fill in the ‘Input Dataset’ and ‘Coordinate System’ fields as 
described above and select ‘Run’................................................................................................................ 68 
Figure 71. With the high resolution tiff selected on the left pane, (1) go to the ‘Raster Layer’ tab, (2) 
select ‘Stretch Type’ and then ‘None’ from the drop down menu. ............................................................. 69 
Figure 72. (1) Select the ‘Map’ tab, (2) then click on the ‘Select’ tool, and (3) lastly click on the first 
segment. ...................................................................................................................................................... 70 
Figure 73. Fill in the fields in the ‘Clip Raster’ pane as indicated and select ‘Run’. ................................. 71 
Figure 74. For all the layers, (1) select the raster layer on the left pane, (2) go to the ‘Raster Layer’ tab, (3) 
select ‘Stretch Type,’ and (4) click on ‘None.’ ........................................................................................... 71 
Figure 75. Right click on the raster layer, select ‘Data,’ and click on ‘Export Raster.’ Fill in the pop up 
window as described in step 10................................................................................................................... 72 
Figure 76. Open the PNG of the quadrat in Paint3D, (1) click on the ‘Select’ tool, (2) use it to highlight 
the whole quadrat, (3) rotate until the quadrat is square with the screen, (4) and select ‘Crop.’ ................ 73 
 



 1 

Abstract 
This document provides a detailed standard operating procedure (SOP) for identifying, annotating, 
and extracting estimates of corallivory, or coral predation, observed on coral reefs using Structure-
from-Motion (SfM) techniques. These procedures were developed by the Ecosystem Sciences 
Division (ESD) at the NOAA Pacific Islands Fisheries Science Center (PIFSC) in collaboration 
with the University of Hawaiʻi at Mānoa. This workflow, applied to coral reefs around Oʻahu, 
Hawaiʻi, consists of five key steps: (1) image collection, (2) data management and quality control, 
(3) generation of 3D models and 2D orthomosaics, (4) setting up ArcGIS Pro for model annotation, 
and (5) annotating procedures for corallivory. Steps one through three have previously been 
outlined in other SOPs; therefore, they will not be described in detail here. This SOP focuses on 
steps four and five which include setting up a Geodatabase specific to corallivory annotations, 
preparing models in ArcGIS Pro for annotation, the methodology used for annotation, and a 
description of different annotation categories. This SOP is the result of comprehensive 
methodological testing, both underwater and using different annotation tools within ArcGIS Pro. 
While the following procedures are designed to provide a foundation for future uses that meet ESD 
needs, we primarily use commercially available cameras and software, making these methods 
adaptable based on programmatic capacity and needs. 

https://repository.library.noaa.gov/view/noaa/22753
https://repository.library.noaa.gov/view/noaa/22753
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1. Introduction 
Coral reefs are important undersea oases that provide innumerable goods and services for humanity 
(Moberg and Folke 1999). For example, global coral reef tourism is estimated to produce U.S. $36 
billion in annual revenue (Spalding et al. 2017), and shoreline protection by reefs substantially 
reduces costs associated with erosion and flooding (Beck et al. 2018). Coral reefs are also 
ecologically important. Although they cover only 0.1% of the ocean floor, they are among the 
most species-rich ecosystems on Earth (Knowlton et al. 2010). But despite our heavy reliance on 
coral reefs and their ecological importance, there has been a 30 to 50% reduction in global coral 
reef cover due to increasing anthropogenic stressors at both local and global scales (Birkeland 
2019; National Academies of Sciences, Engineering, and Medicine 2019). These combined effects 
have caused a decline in coral cover around the main Hawaiian Islands (MHI) since at least the 
late 1990s (Friedlander et al. 2005). Because of the many socioeconomic and ecological goods and 
services coral reefs provide worldwide, their protection is imperative. Addressing global stressors, 
such as ocean warming due to climate change, will take time and cooperation at the international 
level. However, evidence suggests that local management can help offset global changes or at least 
buy reefs time until carbon emissions are stabilized (Kennedy et al. 2013; Anthony 2016; Donovan 
et al. 2021). 

Corallivory, or coral predation, is an important ecological process on coral reefs, but at high levels, 
can lead to coral decline (Rotjan and Lewis 2008; Rice et al. 2019). Moreover, corallivory can act 
synergistically or additively with other stressors, further exacerbating the threats corals face. 
Corallivores encompass a variety of taxa such as annelids, mollusks, crustaceans, echinoids, and 
fishes, which consume the mucus (mucus eaters), polyp tissue (browsers), and/or skeleton of corals 
(scrapers and/or excavators) (Cole et al. 2008; Rotjan and Lewis 2008). Direct and indirect 
corallivore-coral interactions are known to affect corals at the colony level in Hawai‘I 
(Jayewardene et al. 2009; Counsell et al. 2019). The removal of coral tissue and/or skeleton can 
lead to mortality (direct effect). Additionally, because corals are limited by metabolic resources, 
corallivory can inhibit overall growth, sexual reproduction, and alter morphology (indirect effects) 
while energy is directed to wound healing (Henry and Hart 2005; Lenihan HS and Edmunds PJ 
2010; Palacios et al. 2014; Pratchett et al. 2020). Lesions caused by predators do not always heal, 
making them more susceptible to disease (Bak and Steward-Van Es 1980). Moreover, outbreaks 
of corallivores can result in mass mortality of corals. This phenomenon has been well documented 
on the Great Barrier Reef and French Polynesia, where predation by the crown-of-thorns sea star 
(Acanthaster planci), a voracious corallivore, was the leading source of coral mortality prior to 
recent bleaching events (De’ath et al. 2012; Kayal et al. 2012). Further reducing coral reef recovery 
after disturbance events is some corallivores, such as the cushion sea star (Culcita novaeguineae) 
in Hawai‘i, preferentially feeding on juvenile coral colonies (Glynn and Krupp 1986). 

Having tools to rapidly monitor and document threats over large reef areas is imperative for 
management interventions, as some corallivores may be increasing in abundance around some of 
the MHIs (Escontrela unpublished data). With increasing predator numbers, coral mortality will 
likely increase along with reductions in coral reproduction and growth. Moreover, as coral cover 
decreases due to anthropogenic threats, coral predation may intensify. Such was the case on Florida 
coral reefs where predation rates by parrotfishes were documented to increase in areas where coral 
cover was low and preferred coral species were rare (Burkepile 2012). Quick assessments for 
changes in predation pressure will allow managers to enact management interventions, such as 
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corallivore removals, in a timely manner which could increase the probability of success. For 
example, in the Great Barrier Reef, one of the best management interventions in the face of 
increasing crown-of-thorns abundances is removal at the onset of population outbreaks(Bos et al. 
2013). Additionally, because corallivory can be an important determinant of coral outplant success 
during restoration efforts, coral reefs should also be monitored for corallivory prior to and during 
coral outplanting. In the Red Sea, corallivory rates on Stylophora spp. transplants were 2.2-fold 
higher than those experienced by naturally occurring corals of the same species (Horoszowski-
Fridman et al. 2015). Given that corallivory rates can be an important determinant of coral reef 
health and that it can greatly affect the success of coral restoration efforts, tools to quantify 
corallivory rapidly and accurately are needed. Although in-water corallivore surveys can be time 
consuming, a growing number of projects are using imagery-based methods from which 
corallivore estimates could also be extracted.  

Past monitoring techniques for corallivory have included in situ surveys and analysis of 2D benthic 
imagery collected via photoquadrats. While in situ surveys provide the most accurate way to 
document corallivory, they tend to be expensive because they require extended boat use and 
underwater time. Alternately, analysis of 2D photoquadrats tends to be inaccurate because 
quantifying metrics from a 2D image captured from a 3D environment often misses cryptic bite 
marks which may be hidden under overhangs or within crevices (Bonaldo and Bellwood 2011; 
Rice et al. 2020). Structure-from-Motion (SfM) is a photogrammetric method used to create 3D 
models from a collection of hundreds to thousands of 2D images. Large-area imaging techniques 
and SfM technologies are increasingly being used by reef managers to collect coral reef imagery 
more efficiently and to collect data on multiple metrics at the same time (e.g., coral cover, rugosity, 
and coral growth) (Bryson et al. 2017; Ferrari et al. 2017; House et al. 2018; Lange and Perry 
2020; Kornder et al. 2021). SfM surveys drastically reduce the amount of time needed underwater 
and different observers can consistently and accurately annotate models with minimal training. 
This technology allows for the surveying of a broader spatial extent as underwater time can be 
reallocated from conducting surveys at one location to gathering images for different models at 
different sites. It is important to note, however, that post-processing time can be high. SfM 
technologies allow researchers to visualize the reef in 3D which could allow for more accurate 
estimates of corallivory than 2D photoquadrats, with the option to extract a whole suite of 
complementary reef metrics. 

In this standard operating procedure (SOP), we document the workflow for extracting corallivory 
estimates from SfM models of coral reefs. The pipeline consists of five steps: (1) image collection, 
(2) data management and quality control, (3) generation of 3D models and 2D orthomosaics, (4) 
setting up ArcGIS Pro for model annotation, and (5) annotating corallivory on SfM models. Steps 
one through three have previously been outlined in other SOPs, therefore they will not be described 
in detail here. This SOP focuses on steps four and five which include setting up a Geodatabase, 
preparing models in ArcGIS Pro for annotation, and the methodology used for annotation. This 
SOP is the result of comprehensive methodological testing. The methodology along with in-water 
surveys was applied at coral reefs around the island of Oʻahu, Hawaiʻi. Ten coral reef sites that 
encompass a variety of coral habitat types, corallivore abundances, and percent coral cover were 
selected. It is our hope that the workflow discussed in this SOP can be easily adapted to other coral 
reef and marine ecosystem monitoring programs, while considering local coral species and types 
of corallivory. 
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2. Materials needed 
To use this SOP the following materials are needed: 

● For in-water image collection: 
○ Dive slate with pencil 
○ SfM datasheet 
○ 20-meter transect, weighted down at both ends  
○ Ground control points (3+) 
○ Canon SL2 or SL3 with Ikelite housing 
○ 18% gray card to white balance at depth 
○ Optional: fishing weights spray painted in bright color (i.e., neon pink)  

● For model processing and annotation: 
○ Agisoft Metashape 
○ ArcGIS Pro 
○ Viscore 
○ Mouse with a middle scroll bar wheel (required for Viscore) 
○ Optional: a tablet with an electronic pencil and/or an external monitor 
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3. Model generation 
This section goes over the general steps required to create SfM models, from image collection to 
building models in Agisoft. The “Processing Photomosaic Imagery of Coral Reefs Using 
Structure-from Motion Standard Operating Procedures” SOP will be referenced throughout this 
section and contains detailed, step-by-step directions for each of the broad steps described below. 
It will be referred to throughout this document as the “SfM SOP.” The sections below refer to 
specific sections of the SfM SOP (linked above) and detail ways in which these methods deviate 
from the earlier SOP. 

3.1 Image Collection 

The first step in the pipeline will be to collect underwater imagery for the SfM models. Refer to 
section 2.1 of the SfM SOP which covers camera setup and settings, scale bars and markers, and 
underwater survey methodology. At the time of this writing, an updated version of the SfM SOP 
was created with new camera settings. However, during method development for this SOP, the 
camera settings from the older SfM SOP (linked above) were used. It is also important to note that 
most digital cameras can be used to generate SfM models.  

Optional: If the surveyor is trying to monitor specific areas along a transect, such as surveying 
quadrats at specific meter marks, it is recommended that they place something highly visible, such 
as a spray-painted fishing weight, in those areas before image collection (Figure 1). 

When time is available, we recommend collecting additional close-up images of coral heads with 
excess predation or that may be difficult to annotate in the orthomosaic. It is also a good idea to 
take note of corallivorous fishes (i.e., parrotfish, triggerfish, blennies, and pufferfish) and 
invertebrates (i.e., snails, cushion stars, and crown-of-thorns) in the area. These notes can be 
helpful when figuring out the likely sources of coral predation while annotating. 

 
Figure 1. A spray-painted fishing weight is used to mark where quadrats will be drawn in ArcGIS 
Pro. 

https://repository.library.noaa.gov/view/noaa/22753
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3.2 Data Management and Quality Control 

The images gathered for the SfM models will need to be stored and undergo quality control 
procedures. Refer to section 2.2 of the SfM SOP which covers camera download, saving images 
to site folders, quality control, and, if necessary, using Adobe Lightroom to adjust image exposure. 

3.3 Generating 3D Models and 2D Orthomosaics 

Once images have been stored in the proper folders and undergone quality control, they can be 
used to create 3D models and 2D orthomosaics. Refer to section 3 of the SfM SOP for instrustions 
on how to generate 3D point clouds and 2D orthomosaics in Agisoft and how to visualize 3D point 
clouds and underlying imagery using Viscore. Viewing the 3D structure and underlying imagery 
is crucial to generating quality annotations. If Viscore is not available, Agisoft can also be used to 
view underlying imagery. The SfM SOP describes this process. Contact 
courtney.s.couch@noaa.gov for the most recent version of the Suka et al. (2019) SOP. 
 

mailto:courtney.s.couch@noaa.gov
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4. Setting up ArcGIS Pro for Model Annotation  
ArcGIS Pro (v2.8.0 or later) should be used to annotate orthomosaics created in Agisoft. This 
section describes how to upload orthomosaics to ArcGIS Pro, add transect lines and quadrats for 
annotation boundaries, and create a geodatabase to record data. Creating an original geodatabase 
(section 4.1) only needs to be done once per project. Every step in sections 4.2, 4.3, and 4.4 needs 
to be replicated before annotating each individual site or orthomosaic. This section assumes a very 
limited working knowledge of ArcGIS Pro. 

4.1 Creating the Geodatabase 

Before annotations can begin, a Geodatabase must be created. The Geodatabase will be used to 
create the attribute domains which will provide annotators with standard drop down menus from 
which to choose. The following section outlines the steps for creating the Geodatabase and the 
specific column headers and codes for each column. Descriptions of each column and all the codes 
are covered in more detail in Appendix 1. This step only needs to be completed once for the whole 
project (i.e., it is unnecessary to create a new geodatabase for each new site/transect that is being 
annotated). 

Adapted from the SfM SOP Appendix. 
1. Create a table in Excel (e.g., Figure 2). This will later be converted to attribute domains 

in the Geodatabase (GDB) in ArcGIS Pro. Attribute domains are rules in a GDB used to 
constrain the values allowed in any particular attribute for a table or feature class within, 
which will let the analyst utilize a standard drop down menu. Short codes make 
conversion into data clouds easier, although full names can be used according to what is 
surveyed.  

a. Each column in the Excel file will later be a column in the attribute table in 
ArcGIS Pro. All cells filled in below the header row will be a confined drop-down 
option in the attributes table. For no confinements in a given column, leave the 
cells under the header column blank.  

b. Note: the CORAL_CODE column in the figure below is cut off and does not 
contain a complete list of coral species. A description of Oʻahu’s most common 
species can be found in Appendix 1. However, it is best to include all the coral 
species likely found in the region of interest, even if they are rare, as it is difficult 
to edit the GDB later. 
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Figure 2. Excel table of GDB domains. Once imported into ArcGIS Pro, columns C, E, F, G, and I 
will have corresponding drop-down options. Columns A, B, D, H, J, and K will need to be manually 
filled in using ArcGIS Pro. 

2. Name this table (e.g., Corallivory_MHI_codes) and save in a GDB folder (located 
generally within the project folder) as an .xlsx file.  

3. Convert the Excel file to CSV (comma delimited) following the same naming convention 
as the Excel file. 

4. Open an existing ArcGIS Pro file. 
5. Go to Analysis → Tools. On the right side of the screen, search and select ‘Create File 

Geodatabase (Data Management)’ (Figure 3). 
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Figure 3. Open an ArcGIS Pro file. (1) Under the ‘Analysis’ tab, select ‘Tools’. (2) On the right side 
of the screen, search for and select ‘Create File Geodatabase’. 

6. Fill in the following parameters and press the ‘Run’ button (Figure 4): 
a. File Geodatabase Location: Path to the folder where the GDB will be stored (the 

same folder where the Excel and CSV files are located, e.g., 
M:\Corallivory_MHI\Corallivory_MHI_GDB_v2). 

b. File GDB Name: Name of geodatabase. 
c. File Geodatabase Version: Current. 
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Figure 4. In the ‘Create File Geodatabase’ pop up window, fill in the ‘File Geodatabase Location’ 
field with the path to where the GDB will be store, the ‘File Geodatabase Name’ field with the name 
of the GDB, and select ‘Current’ in the ‘File Geodatabase Version’ drop down meni. Once all fields 
are filled out, select ‘Run’ on the bottom right of the pop up window. 

7. Go to Analysis → Tools. On the right side of the screen search for and select ‘Table to 
Domain (Data Management)’ (Figure 5). 
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Figure 5. (1) Under the ‘Analysis’ tab on the top of the screen, select ‘Tools’ icon. (2) On the right 
side of the screen, search for and select ‘Table to Domain’. 

8. Fill in the following parameters and press the ‘Run’ button (Figure 6): 
a. Input Table: Table containing coded field values and description 

field values (the CSV file from step 1). 
b. Code Field: Header name of the first column of the CSV file (e.g., if looking at 

figure 2, type ‘SITE’). 
c. Description Field: Same field as above (i.e., ‘SITE’). 
d. Input Workspace: The path to geodatabase created in step 6a. 
e. Domain Name: Same as ‘Code Field’ (i.e., ‘SITE’). 
f. Domain Description: Same as ‘Code Field’ (i.e., ‘SITE’). 
g. Update Option: Append the values. 
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Figure 6. Fill in the parameters in the ‘Table to Domain’ window as follows and select ‘Run’. 

9. Repeat steps 7 and 8, the ‘Table to Domain’ tool, for all attribute 
domains per column.  

10. Once all list domains are added, go to Analysis → Tools. On the right side of the screen 
search for and select ‘Create Feature Class (Data Management)’ (Figure 7). 
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Figure 7. (1) Under the ‘Analysis’ tab, select ‘Tools’. (2) On the right side of the screen, search for 
and select ‘Create Feature Class’. 

11. Fill in the following parameters and press the ‘Run’ button (Figure 8): 
a. Feature Class Location: Path to geodatabase created in step 6.  
b. Feature Class Name: Template. 
c. Geometry Type: Multipoint.  
d. Template Feature Class (optional): Leave blank.  
e. Has M (optional): No.  
f. Has Z (optional): No.  
g. Coordinate System (optional): WGS1984 UTM Zone 4N.  
h. Feature Class Alias: Leave blank. 

 
Figure 8. Fill in the parameters in the ‘Create Feature Class’ window as follows and select ‘Run’. 

12. The template feature class will automatically be dropped into the Table of 
Contents under the ‘Map’ drop down menu on the left side of the screen 
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(Figure 9).  
13. Go to Analysis → Tools. On the right side of the screen search for and select ‘Add Field 

(Data Management)’ (Figure 9). 

 
Figure 9. (1) Under the ‘Analysis’ tab select, ‘Tools’. (2) On the right side of the screen, search for 
and select ‘Add Field’. 

14. Repeat this step for each column without drop-down options (Table 1). Fill in the 
following parameters and press the ‘Run’ button (Figure 10a): 

a. Input Table: Template.  
b. Field Name: Header name of the column in the CSV file (e.g., SITE).  
c. Field Type (Table 1): 

i. ‘Text’—if inputting letters OR letter and number combinations into field 
during annotation. 

ii. ‘Long (large integer)’—if inputting just numerical values into field during 
annotation. 

d. Leave remaining cells blank. Make sure to disable ‘Field IsNullable’ and ‘Field 
IsRequired’. 

15. Repeat this step for each column with drop-down options (Table 1). Fill in the following 
parameters and press the ‘Run’ button (Figure 10b): 

a. Input Table: template.  
b. Field Name: Header name of the column in the CSV file (e.g., QUAD_N).  
c. Field Type (Table 1):  

i. ‘Text’ - if drop-down options include letters OR letter/number 
combinations. 

ii. ‘Long (large integer)’—if drop-down options are just numerical values.  
d. Field Domain: Same as Field Name (e.g., QUAD_N).  
e. Leave remaining cells blank. Make sure to disable ‘Field IsNullable’ and ‘Field 

IsRequired’. 
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Figure 10. Fill in the parameters in the ‘Add Field’ window as follows and select ‘Run’ for columns 
(A) without drop-down options and (B) with drop-down options. The ‘Field Type’ will vary 
depending on the input values or drop down options (Table 1). ‘Field Domain’ should remain blank 
for columns without drop down options and it should match the ‘Field Name’ for columns with 
drop down options. 
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Table 1. Column name and type along with field type information to complete steps 14 and 15. For 
columns without drop-down options, leave the ‘Field Domain’ blank. For columns with drop-down 
options, fill in the ‘Field Domain’ with the column name. 

Column name Column Type Field Type 

SITE Without drop-down options Text 

ANNOTATOR Without drop-down options Text 

QUAD_N With drop-down options Long (large integer) 

METER_MARK Without drop-down options Long (large integer) 

CORAL_CODE With drop-down options Text 

BITE_CATEGORY With drop-down options Text 

CONDITION With drop-down options Text 

NUMBER_BITES Without drop-down options Long (large integer) 

OVERLAP_SCORE With drop-down options Text 

BITE_LOCATION Without drop-down options Text 

COMMENTS Without drop-down options Text 

4.2 Importing 2D Orthomosaics into ArcGIS Pro 

Adapted from the SfM SOP section 3.2. 
1. Open a new ArcGIS Pro (v2.8.0 or later) file locally on computer. 
2. Under ‘Blank Templates,’ select ‘Map’ (Figure 11). 

 
Figure 11. Open ArcGIS Pro and select the ‘Map’ icon (boxed in red). 
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3. Fill in the pop up window as follows (Figure 12): 
a. Name: Enter name of site being annotated (e.g., Site#). 
b. Location: Navigate to the ARC folder that contains the orthomosaic TIF file for 

that site (e.g., M:\Corallivory_MHI\HAN-3\Products\ARC). 
c. Check the box, ‘Create a new folder’. 
d. Select ‘OK’. 

 
Figure 12. Screenshot of the pop-up window that appears after the ‘Map’ option is selected along 
with how to complete it. 

4. Remove the ‘World Topographic Map’ by right clicking the name on the left side of the 
screen and selecting ‘Remove’ (Figure 13). 

 
Figure 13. Removing the ʻWorld Topographic Map’. 

5. Use the ‘Add Folder’ option under the Insert tab to add the folder where the 
orthomosaic is located (e.g., M:\Corallivory_MHI\HAN-3\Products\ARC) 
(Figure 14). 

 
Figure 14. Use the ‘Add Folder’ option to add the folder to the document. 
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6. Upload the orthomosaic using the ‘Add Data’ option under the ‘Map’ tab 
(e.g., M:\Corallivory_MHI\HAN-3\Products2\ARC\HAN3_orthomosaic.tif) 
(Figure 15). 

a. An ‘Unknown Spatial Reference’ message will pop up in the upper right corner, 
ignore this (Figure 15). 

 
Figure 15. Use the ‘Add Data’ option (boxed in red) to import the orthomosaic. The error message 
can be seen on the upper right hand corner in the blue box. 

b. If the model does not appear on the screen, right click on the previously defined 
name (e.g., Site#) on the left of the screen under ‘Map’ and select ‘Zoom to 
Layer’ (Figure 16). 

 
Figure 16. Use the ‘Zoom to Layer’ option on the left side of the screen if the model is not visible. 

7. Go to Analysis → Tools (Figure 17a). 
8. On the right side of the screen, search for and select ‘Define Projection’ (Figure 17a). Fill 

in the following parameters and press the ‘Run’ button (Figure 17b): 
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a. Input Dataset or Feature Class: Navigate to current orthomosaic (e.g., 
M:\Corallivory_MHI\HAN-3\Products2\ARC\HAN3_orthomosaic.tif).  

b. Under ‘Coordinate Systems,’ set ‘Current XY’ to ‘WGS 1984 
UTM Zone 4N.’ To do so, click on the globe next to the drop 

down menu ( ) and go to ‘Projected Coordinate System’ → 
‘UTM’ → ‘WGS 1984’ → ‘Northern Hemisphere’ → ‘WGS 
1984 UTM Zone 4N.’ 

i. The coordinate system will be the same regardless of 
geographical location. 

ii. If not previously done, right click to ‘Add to Favorites.’  
c. If the model disappears after hitting ‘Run’ and displays, ‘Define 

Projection complete’ on the bottom right, repeat step 6b and ‘Zoom to 
Layer’. 

Figure 17. (A) Go to the ‘Tools’ section under the ‘Analysis’ tab (boxed in red). On the right side of 
the screen, search for and select ‘Define Projection’. (B) Fill in the parameters as described above. 

9. The model colors will likely be incorrect. Click the model layer, go to the 
‘Raster Layer’ tab at the top, click on the drop down menu under ‘Stretch 
Type’ and change to ‘None’ (Figure 18).  
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Figure 18. (1) Select the ‘Raster Layer’ tab, then (2) navigate to ‘Stretch Type’ and select ‘None’ to 
color correct the model. 

10. The orthomosaic should already be properly scaled if it was scaled and 
oriented in Agisoft; however, confirm it is correctly scaled by using the 
‘Measure’ tool under the ‘Map’ tab to measure an object of known length 
(e.g., a scale bar) (Figure 19). 

a. If the orthomosaic did not scale properly, revisit the SfM SOP 
(section 3.1E) to rescale the model and export a new orthomosaic.  

 
Figure 19. Use the ‘Measure’ tool (boxed in red and under the ‘Map’ tab) to measure an object in 
the model to ensure it is correctly scaled. In the figure above, the scale bar was measured and has a 
length of 0.5 meters. Note: scale bars may be different lengths. Become familiar ahead of time with 
the scale bar(s) used for proper scaling and orientation. This project used both 0.25 and 0.5 meter 
scale bars (target to target). 



 21 

4.3 Adding Transects and Quadrats to an Orthomosaic in ArcGIS Pro 

1. Under the ‘View’ tab on the top of the screen, click ‘Catalog Pane.’ Drag and 
drop the new window to the right side of the screen to pin it (Figure 20). 

 
Figure 20. Click the ‘Catalog Pane’ option (boxed in red) under the ‘View’ tab. A ‘Catalog’ window 
will appear. Drag and drop to the right of the screen to pin it into place. 

2. To create the transect, right click on the site’s ARC folder in the Catalog and select 
New  Shapefile (Figure 21a). Fill in the pop-up window as follows and press the ‘Run’ 
button (Figure 21b): 

a. Feature Class Name: site#_transect.  
b. Geometry Type: Polyline. 
c. Coordinate system: WGS 1984 UTM Zone 4N (change as in step 8b 

from the previous section).  
d. Leave everything else as is. 
e. Note: transect length and location will vary depending on the project and research 

question. For the purposes of this SOP, we laid a 20-m transect over the reef and 
parallel to shore.  
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Figure 21. (A) Right click on the ‘ARC’ folder in the Catalog and select ‘New’ → ‘Shapefile’. (B) 
Fill in the ‘Creature Feature Class’ fields as previously described. 

3. In the ‘Edit’ tab, select ‘Edit’ → ‘Create.’ Drag the pop up window to the right 
side of the screen to pin it there, as was done in step 1 (Figure 22). 

 
Figure 22. (1) In the ‘Edit’ tab, first select ‘Edit’ and (2) then click on ‘Create.’ 

4. In the ‘Create Features’ window (on the right side of the screen), click 
on site#_transect and make sure the construction tool is the ‘line’ option 
(Figure 23a).  

a. To make the line a more vibrant color (which will make it easier 
to see on the dynamic background), double click on the line 
feature on the left side window under ‘Map’ → ‘Site#_transect’. 
This will open a ‘Symbology’ window on the right side of the 
screen. Select ‘Highway’ for a highly visible transect line 
(Figure 23b). 
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Figure 23. (A) First make sure the ‘line’ option is selected in the ‘Create Features’ pane on the right 
side of the screen. (B) Change the type of line by (1) double clicking on the line under the transect 
name on the left side of the screen and (2) clicking the ‘Highway’ option on the right side of the 
screen. 

5. Turn on the ‘Dynamic Constraints’ option prior to drawing transects by clicking 
once on the icon, found at the bottom of the screen (Figure 24).  

 
Figure 24. Turn on the ‘Dynamic Constraints’ option at the bottom of the screen (boxed in red). 

6. Zoom into the layer ‘site#_orthomosaic.tif’ and click once at the designated 
starting point for the first quadrat of the transect. For this project, these points 
were marked with a pink/red fishing weight (if a fishing weight is not visible or 
was not used, refer to the project metadata to locate which meter marks were 
used for the quadrats) (Figure 25). 

a. Note: due to the resolution of the orthomosaic, it may be necessary to 
reference the raw imagery using Viscore/Iview to locate the fishing 
weights/meter markers.  

7. After the first click, drag the mouse to draw a “best-fit” line along the transect 
tape visible in the orthomosaic. Drag the mouse exactly 1-meter (3.28-ft), then 
double click to fix the line into place (Figure 25). 
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Figure 25. For each transect line, click at the pink weight, follow the transect line for 3.28 ft (1 m) 
and double click to fix the line into place. 

8. Repeat steps 6 and 7 for all the quadrats along the transect (this project analyzed 
seven quadrats per transect).  

a. When done, zoom out. Seven same-length lines should be visible at 
equal intervals along the model (Figure 26) (distances between lines 
may vary slightly due to the curvatures of the transect line along the 
reef).  

9. Once all 1-m transect lines are drawn, go to the ‘Edit’ tab and hit ‘Save.’ Then, 
go to the ‘Map’ tab and click ‘Explore’ to stop editing (Figure 26). 

 
Figure 26. Once all the 1-m segments have been drawn, zoom out to ensure seven are visible. (1) Go 
to the ‘Edit’ tab and hit ‘Save.’ (2) Lastly, go to the ‘Map’ tab and select ‘Explore.’ 
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10. To create the quadrats, right click on the transect layer (Site#_transect) on the 
left side of the screen, click on ‘Selection,’ then click on ‘Select All’ (Figure 
27). 

 
Figure 27. Right click on the transect layer on the left side of the screen then press ‘Selection’ and 
‘Select All’ from the drop down menus. 

11. Go to ‘Analysis’ → ‘Buffer.’ Fill in the ‘Geoprocessing’ pane on the right side of the 
screen as follows and press the ‘Run’ button (Figure 28): 

a. Input features: site#_transect.  
b. Output Feature Class: site#_segments.  
c. Linear Unit: 0.5 Meters.  
d. Side Type: Full.  
e. End Type: Flat. 
f. Method: Planar.  
g. Dissolve Type: No Dissolve. 
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Figure 28. Select the ‘Buffer’ option (boxed in red) in the ‘Analysis’ tab. Then fill in the ‘Buffer’ 
pain on the right side of the screen as previously described. 

12. Once step 11 is completed, segments (quadrats) will be drawn around the 
transect lines and should be exactly 1-m wide (Figure 29).  

a. At this point, the segments may be filled in. To correct the color and 
transparency of the segments, double click on the Site#_segments layer 
on the left window which will make the Symbology window reappear 
on the right. Use this window to choose the outline and fill color of the 
segments (Figure 29).  

 
Figure 29. After step 11, quadrats will be drawn around the transect lines. To fix the shading and 
outline, (1) double click on the site#_segments layer on the left side of the screen and (2) select the 
‘Black Outline’ option on the right. 
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4.4 Adding Geodatabase to ArcGIS Pro Projects  

1. To view the project folder in ArcGIS Pro, navigate to ‘Insert’ → ‘Add 
Folder’ (Figure 30). 

 
Figure 30. With the model open in ArcGIS Pro, (1) navigate to the ‘Insert’ tab and (2) select ‘Add 
Folder’. 

2. In the pop up window, select the project's parent folder that includes the 
geodatabase and the individual ArcGIS Pro files and click ‘OK.’ 

3. In ‘Catalog’ (View → Catalog Pane), navigate to the project’s most recent 
version of the Geodatabase. 

a. Folders: Corallivory_MHI → select the file in the folder with the 
most recent Geodatabase (i.e., 
M:\Corallivory_MHI\Corallivory_MHI_GDB_v2\Corallivory_MH
I_v2.gdb). 

4. Expand the drop down menu for the GDB (i.e., Corallivory_MHI_v2.gdb) 
by clicking on the arrow to the left of the file name (Figure 31a). 

5. Right click on the ‘template’ feature class and select ‘Copy’ (Figure 31a). 
6. Right click on the Geodatabase (in this case, ‘Corallivory_MHI_v2.gdb’) and 

click ‘Paste’ (Figure 31b). It will take a few moments for this to paste. 
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Figure 31. After navigating to the Geodatabase in the Catalog, (A) (1) click on the arrow to the left 
of the Geodatabase name, (2) right click ‘template’ and (3) select ‘Copy.’ (B) Go back to the 
Geodatabase, (1) right click and (2) select ‘Paste.’ 

7. Right click on the new template copy (it will likely show up as ‘template_1’) 
and select ‘Rename.’ 

a. Rename feature to ‘SITE_#.’ 
8. Drag the new template copy (‘SITE_#’) from the catalog pane to the contents 

tab and drop it under ‘Map.’ 
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5. Extracting Corallivory Data Using ArcGIS Pro 
The following section outlines the annotation process and covers best practices and suggestions 
on the best way to look for corallivory bite marks. It also describes how to use ArcGIS and Viscore 
to annotate models for different types of corallivory. It is important to note that these surveys might 
not be as accurate during bleaching events, when browsing bite marks and bleaching could be 
confused with one another. Moreover, annotators should have some familiarity with coral 
conditions and diseases as some may be easily confused with corallivory. Appendix 1 reviews 
Oʻahu-specific codes used to annotate coral reef models for corallivory. For fish bite mark 
categories (e.g., EXBR, SCSP, EXCAV, and SCRAP), follow the methods outlined in section 5.2. 
For sea star and Drupella predation, follow the methods in section 5.3. 

5.1 Extracting Coral Area by Species 

Some types of predation (e.g., Drupella, sea stars) leave behind large swaths of white, dead 
skeleton which is used to estimate the percent cover of corallivory for these types of predators. 
This method could also be used in areas of concentrated fish predation when individual bites 
cannot be distinguished. In order to determine percent corallivory for these predators from SfM 
models, it is necessary to calculate coral area by species in each quadrat. This section discusses 
general steps used to extract the area of corals by species, while section 5.3 presents a general 
overview of how to use these data to calculate percentage of corallivory. 

1) Extract orthblocks of the areas that will be annotated (reference Appendix 2). 
2) Upload orthoblocks to CoralNet and annotate to the lowest taxonomic level (the “Analysis 

of Benthic Survey Images via CoralNet” SOP outlines the process of annotating in 
CoralNet). 

3) Multiply the percentage coral cover of each species by the area of the orthoblock.  
a) For example, if the orthoblock area represents a 1m × 1m quadrat, the area of each 

coral species would be calculated by multiplying the percent coral cover of that 
species by 1m2. 

5.2 Annotating Fish Predation 

It is recommended that the person annotating uses two monitors and/or a tablet. The following 
software are required for annotation: 

● ArcGIS Pro—for annotation and initial inspection 
● Viscore—for viewing underlying imagery 
● GoogleChrome–for viewing underlying imagery 

If Viscore is not available to the annotator, underlying imagery can be viewed using Agisoft. 
Information on how to use Agisoft for this purpose can be found in the SfM SOP. Contact 
courtney.s.couch@noaa.gov for the most recent version of the Suka et al. (2019) SOP. 

Calibration among annotators is critical. A new annotator and a trained annotator should agree to 
annotate the same quadrats. They should choose a variety of sites with different topographies, coral 
composition and cover, and levels of predation. Once they have annotated the same quadrats, 
compare results. The new annotator is ready when there is greater than 90% agreement between 

https://repository.library.noaa.gov/view/noaa/42469
https://repository.library.noaa.gov/view/noaa/42469
https://repository.library.noaa.gov/view/noaa/42469
mailto:courtney.s.couch@noaa.gov
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the two users. For fish predation, the annotator will count the number of bite marks per corallivory 
category per coral species per condition per quadrat.  

5.2.1 Getting ready to annotate 

1. Open the project in ArcGIS Pro. Depending on the speed of the computer, it might take 
some time for the project to open. 

a. Site folder → products → ARC → site name → select the file with the ArcGIS 
Pro symbol ( ). 

2. Zoom in to the quadrat that is being annotated. 
3. On the left side of the screen, under the ‘Map’ drop down menu, make sure the multipoint 

feature is checked on (Figure 32). 

 
Figure 32. When project is open, zoom into the quadrat and turn the check mark on for the 
multipoint feature on the left side of the screen (boxed in red). 

4. Go to ‘Edit’ tab  ‘Edit’ (Figure 33). 

 
Figure 33. Select the ‘Edit’ option under the ‘Edit’ tab. 

5. On the far right side of the screen, click on the right pointing arrow that appears next to 
the multipoint tool (Figure 34a). Fill in the site name and annotator fields (Figure 34b). 
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These fields will be the same for the whole transect, prefilling them will auto-fill them 
whenever a new row of annotations is created in the attributes table.  

a. SITE—three letter code followed by the number transect at that site. This should 
match the site name and number on the SfM tracking sheet. 

b. ANNOTATOR—the three letter initials of the annotator. 
c. The rest of the fields can either be filled out here for each annotation or in the 

attribute table once the new row corresponding to the annotations is created (step 
6 in the next section). 

  
Figure 34. (A) Click on the right pointing arrow next to the feature name on the right side of the 
screen (boxed in red). (B) Fill in the ‘SITE’ and ‘ANNOTATOR’ fields as described above and 
optionally the rest of the fields for each new annotation combination. 
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6. To begin annotating, click on the icon under the multipoint feature that looks like a box 
with a dot inside and an arrow pointing into it on the right hand side of the screen. This 
will turn on the multipoint annotation tool (Figure 35). 

 
Figure 35. Turn on the multipoint annotation tool by clicking on the icon boxed in red. 

7. Open the attribute table for the multipoint feature. On the left side of the screen, right 
click on the site name (immediately under the ‘Map’ drop down menu) and select 
‘Attribute Table’ (Figure 36). 

 
Figure 36. Right click on the name of the multipoint feature on the left side of the screen and select 
‘Attribute table’. 
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8. Navigate to the Viscore file for that site and double click to open. 
a. Site_folder → Products → Site_name file with Viscore symbol ( ). 

9. Turn on the cameras (Figure 37). 
a. Hover over the right side of the screen and select ‘Cams’ (once clicked, a small 

‘ON’ symbol will show up next to ‘Cams’). 
b. On the bottom left, click on ‘none’ to the right of the word ‘cams.’ Once clicked, 

the symbol will change from ‘none’ to the site name and yellow camera paths will 
appear on the model. Consult the “Guide to Viscore” if the site name or camera 
paths do not appear.  

 
Figure 37. To turn on the cameras, select ‘cams’ on the right side of the screen (boxed in red). The 
small ‘ON’ will appear once ‘cams’ has been clicked. Then select ‘none’ on the bottom left of the 
screen (boxed in blue). 

10. Zoom in to the part of the model that will be annotated. 
a. The pink weight marks the beginning of the quadrat. 
b. If necessary, rotate the model so it matches the orientation in ArcGIS Pro. This 

will make it easier to navigate within the models in both programs. 
c. Viscore controls: 

i. Right click and move mouse up and down to zoom in and out. 
ii. Left click and move mouse up and down to rotate the model. 

iii. Left and right click at the same time and move the mouse to move the 
model. 

Now that ArcGIS Pro and Viscore are set up, the annotation process can begin.  

5.2.2 Annotating fish predation 

This section covers how to annotate fish predation; Drupella and sea star predation follows a 
different methodology (see section 5.3). However, any sea star or Drupella predation observed in 

https://docs.google.com/document/d/1y4kImaIkI6XpgCeYO5vpAKYnoWXklV9HQrALbvewUDg/edit
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a quadrat during these annotations should be noted on the SfM process tracking sheet (or whatever 
process tracking sheet is being used). Also, note any cushion stars, crown of thorns, and/or 
Drupella snails seen anywhere on the model or in the underlying imagery. For fish predation 
(codes: SCRAP, EXBR, EXCAV, SCSP; see Appendix 1), the annotator will count the number of 
bite marks per corallivore category per coral species per condition per quadrat. 

1. Go to Viscore and drop a point on the first coral that will be inspected (Figure 38). 
a. To drop a point, select ‘Alt’ on the keyboard and click the middle wheel/button on 

the mouse. 

 
Figure 38. Drop a point (Point A) on the first coral along the search pattern. 

2. After dropping the point, view the underlying imagery by opening Google Chrome. 
a. Enter localhost:9090/jsd/pq.xhtml in the URL bar and images containing that 

point should appear. 
b. To scroll through the images ‘scroll + left click’ with the mouse or use the up and 

down arrows on the keyboard. 
c. To zoom in or out, simply ‘scroll’ with the middle wheel on the mouse. 

3. View as many images from as many angles as needed to identify corallivory scars. 
a. For colonies that fall both inside and outside the quadrat, only look at the live 

coral within the quadrat, ignore anything outside.  
b. Not all colonies may be visible on the ArcGIS Pro orthomosaic due to low 

resolution, especially smaller colonies, or those under overhangs or in crevices. 
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When viewing underlying imagery for larger colonies, inspect the surroundings 
for colonies that might not be visible in ArcGIS Pro. 

c. For corallivore marks that fall on the quadrat line, count the bite mark as long as 
more than 50% of the bite mark falls within the quadrat. 

4. When corallivory is found, go back to ArcGIS Pro and using the multipoint tool, drop 
point(s) wherever bite marks were spotted in the underlying imagery. 

a. If corallivory is not visible in ArcGIS Pro, try to match the location as closely as 
possible using the underlying imagery as a guide. 

b. Create a new line in the attribute table for each new coral species/bite 
category/condition combination.  

i. For example, scraper bite marks on Pocillopora meandrina that are new 
and scraper bite marks on Pocillopora meandrina that are old will each 
require their own line in the attribute table 

ii. Note: each coral colony does not need a new line, all colonies of the same 
species with the same bite category and condition can be lumped together. 

c. Once done dropping points for the specific coral species/bite category/condition 
combination in ArcGIS Pro, click the button that looks like a box with a check 

mark ( ). This will create a new row in the attribute table that is linked to the 
point(s) that were just created. 

5. A new line in the attribute table will be generated for those points. Fill in the appropriate 
information for the point(s) in the attribute table (Figure 39). Alternately, the information 
could be filled in before completing step 5c (of this section) as described in step 5 of the 
previous section: 

a. Site and Annotator should automatically get filled in if step 5 in section 5.2.1 was 
completed correctly. 

b. Quad_N—quadrat number (drop down menu). 
c. Meter_mark—at what meter is the pink weight placed (approximate to nearest 

meter). Might need to view underlying imagery for this information (type in a 
number). 

d. Coral_code—first letter of genus name followed by first three letters of the 
species name, with some exceptions. See Appendix 1 for taxa list and example 
images (drop down menu). 

e. Bite_category—type of bite mark, see Appendix 1 for list and descriptions (drop 
down menu). 

f. Condition—at what stage of the healing process are the bite marks, see Appendix 
1 for list and descriptions (drop down menu). 

g. Number_bites—there is no need to fill this in, see step 9 in this section. 
h. Overlap_score—the degree to which scars are overlapping (scores range from one 

to four), see Appendix 1 for list and descriptions (drop down menu). 
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i. The overlap score is a rough average per coral species per bite mark 
category per condition category per quadrat. 

i. Comments—note anything unusual or of interest. 

 
Figure 39. Create a new row in the attribute table for each new combination of coral species, bite 
category, and condition in each quadrat. Then fill in the information in each column as described 
above. 

6. Repeat steps 3–6 until all the coral in the quadrat has been inspected. 
a. To move the point on Viscore to a new area, middle click on the point, drag to a 

new spot, and click on ‘snap’ on the bottom left (Figure 40). The new underlying 
imagery should automatically show up in Google Chrome. 

b. Alternatively, if the new imagery is not showing up, on Viscore, delete the point 
that was dropped by going to the bottom left hand side of the screen and selecting 
‘delete’ (Figure 40). Drop a new point using the method described in step 1. 

 
Figure 40. To view a new colony, drag the green point to the desired spot and select ‘snap’ (boxed in 
blue). Alternately, if the new underlying imagery isn’t showing up correctly, delete the point (boxed 
in red) and drop a new point. 

7. After each quadrat is annotated, indicate its completion in a tracking spreadsheet or 
whatever method is being used to track progress.  

a. As corallivory will be absent from some quadrats, tracking will allow users to 
ensure that all quadrats were surveyed and ensure that they do not repeat work 
that has already been completed.  



 37 

b. Note on the tracking sheet if corallivory was absent from any quadrats, if a sea 
star or Drupella snail were found within the model, and/or if any of the quadrats 
had sea star or Drupella predation. 

8. After completing all the annotations on a transect, fill in the ‘number_bites’ column 
following these steps: 

a. Select all the rows in the attribute table. 
b. Right click on the ‘number_bites’ column (Figure 41a).  
c. Select ‘Calculate Geometry’ (Figure 41a). 
d. In the pop up window (Figure 41b):  

i. Under ‘Field (Existing or New),’ select ‘Number_bites’.  
ii. Under ‘Property,’ select ‘Number of Parts’.  

iii. Click OK.  
e. Note: the ‘Edit’ option in the ‘Edit’ tab must be turned on in order to complete 

this step. 

 
Figure 41. (A) Once all rows have been selected, right click on the ‘number_bites’ column and 
select ‘Calculate Geometry,’ (B) fill in the pop up window as shown. 

9. Follow some of these extra recommendations while annotating: 
a. Define a search pattern ahead of time to help keep track of which colonies have 

already been inspected. 
b. For quadrats with a lot of coral, especially Porites compressa and “pieces” of 

massive Porites, upload a screenshot of the orthomosaic to something such as an 
iPad or tablet and use this to cross out previously inspected colonies; this will help 
keep track of progress. 

c. Similarly, rather than annotating on ArcGIS Pro as bite marks are encountered, 
mark them on a screenshot of the orthomosaic on the iPad or tablet. Wait until the 
whole quadrat has been inspected to transfer annotations to ArcGIS Pro.  
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i. Marking annotations on an iPad/tablet will also be helpful in case the 
annotator forgets to save changes and/or if ArcGIS Pro unexpectedly 
crashes. 

d. If not using an iPad or tablet, it is best to annotate one colony at a time. An 
exception to this is when there are colonies of the same species in the surrounding 
area with the same type and condition of predation. 

e. If an annotator is unclear about whether something is a bite mark or not, try to 
find it in at least 3–5 spaced out pictures. This can be especially useful when there 
is sand or other particles in the water column that might make it look like there is 
predation. 

f. Underexposed pictures are better for finding bite marks as they provide much 
higher contrast between healthy and consumed areas. 

g. Annotators must use an external mouse rather than the trackpad on the laptop in 
order to navigate in Viscore. 

h. Have an external monitor and place ArcGIS Pro on one monitor and Viscore/ 
Google Chrome on the other monitor. 

i. Use context clues when unsure about what might be predation. For example, if 
something looks like a parrotfish or blenny bite mark but the annotator is unsure, 
check the surrounding area as these two fishes usually leave several bite marks in 
one area. It may also be useful to check the notes from the image collector in case 
they noted whether they saw any corallivores. 

j. If a sea star or Drupella snail is visible in the SfM model or the underlying 
imagery, note this in whatever tracking spreadsheet is being used for annotations. 
Similarly, make note of any predation from these animals in the tracking sheet. 

k. Save work frequently! 

5.3 Annotating Sea Star and Drupella Predation 

Due to the low incidence of observed predation by Drupella snails and sea stars (crown-of-thorns 
and cushion stars) around Oʻahu, these types of corallivory were not annotated. Instead, a brief 
overview of the general methods that could be applied to quantify corallivory by these types of 
predators is described below. Since these corallivores leave behind large swaths of dead skeleton, 
the percent area of each coral species with a predation scar is estimated within each quadrat (the 
percent predation is out of live and recently dead coral tissue).  

The general methodology requires the annotator to first set up a geodatabase in ArcGIS Pro to 
annotate using polygons. The quadrats are then inspected for Drupella and sea star predation and 
annotated using this tool. The SfM tracking data sheet can be used as a reference to determine 
where this type of predation was seen during the initial fish predation annotation round. As with 
fish predation, it is important to inspect the underlying imagery. Next, the area of each coral species 
within each quadrat is calculated using the methods in section 5.1. Lastly, to determine the percent 



 39 

predation by Drupella snails and sea stars, divide the area of predation from each coral predator 
(by coral species) by the total area of that coral species in the quadrat.  

Because of the inconsistencies in this type of predation across sites and likely high variability, a 
method for comparing these types of predation was not conducted in this study. However, it is our 
hope that these methods are tested by other users as coral predation by these two types of predators 
has proven to be devastating to reefs around the world. 

5.4 Extracting Data from ArcGIS Pro 

Once annotations are complete, the final step is to export the annotations data from ArcGIS Pro. 
Refer to section 3.2 (F) of the SfM SOP which offers step by step instructions on how to extract 
annotations data from ArcGIS Pro.  
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7. Appendix 
Appendix 1. Corallivory Annotation Descriptions (Hawaiʻi) 

This section describes the columns and codes that are in the attributes table commonly used for 
Oʻahu reefs. They can be applied to the other main Hawaiian Islands and provide a starting point 
for other Pacific regions. The attributes table is where annotation data are entered in ArcGIS Pro. 
The columns described below include: (1) coral species, (2) bite mark categories, (3) condition 
categories, and (4) overlap scores. Example images are provided for each description.  

Coral species 

There are over 30 coral species found around the island of O‘ahu. In this section, the most common 
15 coral species are briefly described. More information can be found in: 

● Hawai‘i’s Sea Creatures: A Guide to Hawai‘i’s Marine Invertebrates by John P. Hoover 
● Marine Life Photography by Keoki Stander and Yuko Stender 

The following section is organized by coral family. Each species is categorized as either “Very 
Common,” “Somewhat Common,” or “Rare.” “Very common” species can be found on almost 
every survey, “Somewhat Common” species can be found in about half of all surveys, and “Rare” 
species are encountered every once in a while. The code for each species is also provided. The 
code is made up of the first letter of the genus followed by the first three letters of the species. 

1. Family Pocilloporidae—coral species in this family have a branching morphology. Branches 
are covered with bumpy verrucae. 

a) Pocillopora damicornis (somewhat common, PDAM)—usually found in shallow water, 
uncommon around most of O‘ahu, except in Kaneohe Bay. They form bushy heads with 
slender branches in wave protected areas and thicker branches in areas with wave action. 
Like all Pocilloporidae, it is covered with verrucae. Color varies from light brown to darker 
brown (Figure 42).  

 
Figure 42. (A) Colony-level and (B) close up images of Pocillopora damicornis. 

https://www.amazon.com/Hawaiis-Sea-Creatures-Invertebrates-Revised/dp/1566472202
https://www.marinelifephotography.com/default.htm
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b) Pocillopora meandrina (very common, PMEA)—especially common in high energy 
environments. They form compact branching colonies. Branches look flattened and branch 
tips tend to curve into a “c” shape. Colors range from brown (most common) to green and 
rose pink. These species can attain very pale coloration (Figure 43). 

 
Figure 43. (A) Colony-level and (B) close up images of Pocillopora meandrina. 

c) Pocillopora grandis (uncommon, PGRA)—this is the largest of the Pocillopora species, and its 
size is one of the main defining characteristics, sometimes reaching a few feet in height. The 
branches are tubular and upright, sometimes flattened and forked at the tips. Smaller individuals 
may look similar to P. meandrina but P. grandis has larger spaces between the branches and 
branches typically don’t have the “c” shape (Figure 44). 

Figure 44. A) Colony-level (Photo by Erik Brush) and (B) close up images of Pocillopora grandis. 

2. Family Acroporidae—species of the Acropora genus rarely occur around the main Hawaiian 
Islands. More common are members of the genus Montipora. This genus usually forms encrusting 
or platelike colonies. They have small calyces which are usually surrounded by projections which 
give the coral colonies a rough texture.  

a) Montipora capitata (very common, MCAP)—the most common morphology for this coral 
species is encrusting. However, they can also form plates, cups, and branches in more 
protected environments. They have rounded, rice-like projections between calyces giving 
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them a bumpy appearance. Color varies from dark brown to light beige or cream. The 
darker colonies usually have light edges and tips which do not necessarily indicate 
predation (Figure 45). 

Figure 45. (A) Colony-level and (B) close up images of Montipora capitata. 

b) Montipora patula (very common, MPAT)—this species grows in plates and encrusting 
colonies. The surface is covered by small projections which tend to cluster around the 
widely spaced calyces. When polyps are out, they appear purple or blue. Color varies from 
light tan to brown (Figure 46). 

Figure 46. (A) Colony-level and (B) close up images of Montipora patula. 

c) Montipora flabellata (rare, MFLA)—the most obvious characteristic of this species is its 
vivid fluorescent blue/purple color. They are found in high energy environments and form 
encrusting colonies. Like the other Montipora species, this one has a rough texture due to 
projections between the calyces (Figure 47).  
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Figure 47. (A) Colony-level and (B) close up images of Montipora flabellata. 

3. Family Poritidae—corals in this family have small, tightly packed calyces. The surfaces of the 
colonies are smooth with no projections. A few morphologies exist for species within this family 
such as mounding, lobes, encrusting, or branching fingers. Some Porites species can be hard to 
differentiate and for these surveys, some of them will be grouped together (see below). 

a) Porites compressa (somewhat common, PCOM)—this species has a branching finger 
morphology. In shallow areas, they form rounded heads with fused branches. In deeper 
waters, branches are longer and more finger-like. P. compressa beds can be very large, 
especially in places like Kaneohe Bay. Color varies from light brown to sometimes 
yellowish or bluish gray (Figure 48).  

Figure 48. (A) Colony-level (Photo by Keoki Stender) and (B) close up images of Porites compressa. 

b) Porites lobata (very common, PLOB)*—this species usually forms large, mounding 
colonies. In more energetic environments, they may form encrusting patches. This is 
Hawaiʻi’s most common massive coral. Color varies from yellowish brown to yellowish 
green (Figure 49). 
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Figure 49. (A) Colony-level (Photo by Keoki Stender) and (B) close up images of Porites lobata. 

c) Porites evermanni (somewhat common, PEVE)*—this species looks very similar to P. 
lobata. One of the main differences is that it is usually brownish to bluish gray and never 
has the yellowish color usually present in P. lobata. The polyps are often not retracted 
giving the colony a fuzzy appearance (Figure 50).  

Figure 50. (A) Colony-level and (B) close up images of Porites evermanni (Photos by Keoki Stender). 

* P. lobata and P. evermanni can be easily confused with each other. There are an additional three 
rare species (not described here) that also resemble these two species. For these surveys, Porites 
lobata, Porites evermanni, and the additional three rare species were aggregated into the code 
PMAS (Porites massive). 

3. Family Agariciidae—narrow ridges connect the calyces. Corals in this family have very fine 
tentacles. Most species in this family form encrusting colonies although some form lobes. 

a) Pavona duerdeni (uncommon, PDUE)—colonies of this species form lobes or thick upright 
disks. Younger colonies are encrusting. The surface is smooth and does not have distinct 
visible ridges like other species in this family. Their calyces form star-shaped patterns. 
They are usually a tan color (Figure 51).  
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Figure 51. (A) Colony-level and (B) close up images of Pavona duerdeni. 

b) Pavona varians (common, PVAR)—this species forms encrusting colonies. In protected 
areas, it can form thin plates. The calyces sit in valleys separated by sharp ridges. They 
vary in color from light yellowish tan to brownish gray, greenish or brown (Figure 52). 

 
Figure 52. (A) Colony-level and (B) close up images of Pavona varians. 

4. Family Fungiidae—this is a family of free living corals. They are composed of one solitary 
polyp which tends to be large, flattened, and unattached to the substrate.  

a) Lobactis scutaria (uncommon, LSCU)—can be found shallow or deep but is often lodged 
in crevices or holes. They have an oval shape. Sharp ridges radiate from the central mouth. 
The ventral side also has projections, although not as sharp. Color is usually tan or brown 
dorsally and white ventrally (formally known as Fungia scutaria) (Figure 53). 
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Figure 53. (A) Colony-level and (B) close up images of Lobactis scutaria. 

5. Family Faviidae—species in this family in Hawai‘i are usually encrusting or domelike. They 
tend to have large, easily distinguished calyces.  

a) Cyphastrea ocelina (rare, COCE)—colonies of this species are usually small, encrusting, 
and clumpy. The calyces have sharply raised edges and are usually tightly packed, although 
they remain distinct. Color is usually light brown (Figure 54). 

 
Figure 54. (A) Colony-level and (B) close up images of Cyphastrea ocelina. 

b) Leptastrea bewickensis (uncommon, LBEW)*—this coral usually forms flat, encrusting 
colonies. Calyces are brown and often with whitish centers and pale spaces between them 
(Figure 55). 
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Figure 55. (A) Colony-level and (B) close up images of Leptastrea bewickensis (Photo by Keoki 
Stender). 

c) Leptastrea transversa (rare, LTRA)*—this coral forms an encrusting colony, although not 
as flat as L. bewickensis. It sometimes has rounded lobes. The center of the calyces may be 
green. Color varies from brown to greenish brown to purplish brown (Figure 56).  

Figure 56. (A) Colony-level and (B) close up images of Leptastrea transversa. 

* L. transversa and L. bewickensis can be easily confused with each other. There is an additional 
species (not described here) that also resembles these two species. For these surveys, all three 
species were aggregated into the code LESP (Leptastrea species). 

Corallivory categories 

Fish and invertebrates have different feeding modes which result in different types of predation 
wounds on coral. Mucus eaters, such as Trapezid crabs, consume only the mucus secreted by coral. 
Browsers, such as sea stars and butterflyfish, consume only coral tissue. Lastly, scrapers and 
excavators, which include fishes such as parrotfish and pufferfish, remove both coral tissue and 
skeleton to varying degrees. The categories described below were developed after extensive 
research into coral predation types around Oʻahu, Hawaiʻi. Due to the difficulty in distinguishing 
predation caused by certain species, most of these categories are broad; only two categories are 
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species-specific. Importantly, predation by mucus eaters and butterflyfish cannot be annotated 
because of the lack of or very small size of those predation marks. There are six categories of coral 
predation described below; the code for each is in parentheses. It is important to note that bite mark 
categories will look slightly different depending on the coral species. 
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1. Exallias brevis predation (EXBR)  
The shortbodied blenny (Exallias brevis) (Figure 57a) is frequently found on the reef and inflicts 
one of the most common corallivory bite marks on Oʻahu reefs. They only extract coral polyps, 
resulting in wounds that look like near-perfect circles (with some exceptions) (Figure 57b). There 
will usually be multiple bites within a coral colony or within a cluster of colonies (Figure 57c). 
Bite marks are still visible when they begin to heal and polyps begin to recolonize the wound (these 
should be marked as “healing,” see condition categories below). When there are high densities of 
overlapping blenny bite marks, the annotator should approximate how many bite marks are in a 
small, specific area and extrapolate to the rest of the areas that show similar signs of concentrated 
blenny predation. To estimate the number of bite marks in a small area, look at other images that 
have individual, well defined blenny bite marks to get a size approximation. Using this size 
approximation, estimate how many bite marks there are in the small, high-coverage area. The 
annotator should count the number of blenny bites per coral species per condition category per 
quadrat. Blenny bites are often found on Porites species and are easily distinguishable. At some 
sites, Montipora patula and M. capitata experience high levels of blenny predation; because of the 
irregular surface of this coral genus, blenny predation forms irregular/distorted circles that 
sometimes look like long, white tracks between ridges (Figure 57d). Lastly, blenny bites are 
sometimes found on the branch tips or base of Pocillopora meandrina and P. grandis.  

 
Figure 57. (A) Shortbodied blenny, (B) close up of a blenny bite mark, high density and overlapping 
blenny bite marks on (C) massive Porites and (D) M. capitata. 
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2. Sea star predation (STAR) 
Sea star predation around O‘ahu is inflicted by either the crown-of-thorns sea star (Acanthaster 
planci) (Figure 58a) or the cushion sea star (Culcita novaeguineae) (Figure 58b). Both sea star 
species will climb onto a coral colony, expel their stomach to cover the colony, and secrete 
digestive enzymes which allows them to absorb the coral polyps. Crown-of-thorns predation on 
large coral colonies results in swaths of dead, bare, bright white skeleton (Figure 58c). However, 
they are also capable of causing complete colony mortality. Predation on smaller colonies will 
usually result in total coral mortality. Cushion stars tend to consume smaller colonies and will also 
leave behind a bare, white skeleton with no polyps (Figure 58d). For the purposes of our Oʻahu 
surveys, predation by crown-of-thorns and cushion stars was not distinguished and was grouped 
into the “STAR” category. However, sea stars can often be seen in the SfM models, and their 
presence should be noted in whatever tracking spreadsheet is being used for annotations. For 
STAR predation, percent area of each coral species with a predation scar is estimated within each 
quadrat. The percent predation is out of live and recently dead coral tissue. STAR predation looks 
very similar to bleached coral colonies; therefore, corallivory surveys are likely to be less accurate 
during bleaching events. It is recommended that surveyors wait two months after a bleaching event 
before trying to quantify this type of corallivory. Cushion stars are more selective predators and 
preferentially consume juvenile Pocillopora colonies. However, they have also been observed 
eating Pavona varians, Pavona duerdeni, Montipora patula, and larger Pocillopora colonies. The 
crown-of-thorns sea star is more of a generalist predator and is often found consuming Pocillopora 
meandrina, Montipora patula, massive Porites (i.e., lobata and evermani), and Pavona spp. 
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Figure 58. (A) Crown-of-thorns, (B) cushion star, (C) massive Porites consumed by a crown-of-
thorns sea star (Photo by NOAA), and (D) a juvenile Pocillopora consumed by a cushion star. 
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3. Drupella cornus predation (DRUP) 
Drupella is a genus of marine snail that specializes in consuming coral polyps (Figure 59a). 
Predation by this snail is not common around Oʻahu. Much like sea star predation, Drupella 
predation results in small swaths of dead, bare, bright white skeleton, often at the bases or boarders 
of colonies (Figure 59b-d). Large dead swaths only exist when there are multiple Drupella 
consuming the same colony. While Drupella are often nocturnal, they can sometimes be seen in 
the vicinity during the day and their presence should be noted. For Drupella predation, the percent 
area of each coral species with a predation scar is estimated within each quadrat. The percent 
predation is determined from both live and recently dead coral tissue. Similar to STAR predation, 
Drupella predation can resemble bleaching and the same recommendations should be followed. 
Although sea star and Drupella predation can look very similar, damage inflicted by Drupella 
usually affects much smaller portions of the coral colony when compared to sea star predation. 
This marine snail prefers corals in the genera Pocillopora, Porites and Montipora.  

 
Figure 59. (A) Drupella snail and Drupella predation on (B) Porites compressa, (C) Montipora 
capitata, and (D) Pocillopora damicornis. 
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4. Scaridae species predation (SCSP) 
The parrotfish (Scaridae) family are most commonly known for their herbivory, but they are also 
corallivores (Figure 60a). Because the parrotfish around O‘ahu are usually small in size, their bite 
marks tend to be shallow (a few millimeters deep) as well as small. A parrotfish bite mark is made 
up of two ovals opposite one another, usually with a small gap between the two ovals (Figure 60b). 
Despite looking like two separate bite marks, each pair of ovals counts as a single bite mark. Larger 
parrotfish leave behind bigger, deeper bite marks but these still consist of paired ovals. Parrotfish 
can take part in focused predation, whereby they repeatedly bite the same coral, leaving behind a 
high density of overlapping marks (Figure 60c). When this is the case, the annotator should 
approximate how many bite marks are in a specific area and extrapolate to the rest of the areas that 
show signs of parrotfish predation (the same method as with blenny bite marks). The annotator 
should count the number of parrotfish bites per coral species per condition category per quadrat. 
Parrotfish bite marks are most often found on either massive Porites or Porites compressa. Less 
commonly they can be found on Montipora patula and Montipora capitata (Figure 60d).  

 
Figure 60. (A) Parrotfish (Photo by Reef Guide), (B) close up of a parrotfish bite mark, in this case 
without the gap between the two ovals, (C) high density of overlapping parrotfish bite marks on 
massive Porites, and (D) a parrotfish bite mark on Montipora patula. 

https://reefguide.org/indopac/pixhtml/palenoseparrotfish4.html
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5. Excavator (EXCAV) 
Excavator bite marks around Oʻahu are caused by the barred filefish (Cantherhines dumerilii) 
(Figure 61a), spotted pufferfish (Arothron meleagris) (Figure 61b), and larger parrotfish (Scaridae 
spp.) (Figure 60a). Bite marks from these three fishes are grouped under the “EXCAV” category 
because of their similarity in appearance. In the case of parrotfish bite marks, they should be 
categorized as “SCSP” if they have the appearance described above; if it is a deep wound without 
any discernible shape, it should be categorized as “EXCAV.” These bite marks are very 
conspicuous. Corals with excavator marks have deep chunks missing (deeper than 0.3 cm) with 
bare skeleton clearly visible. When the bite mark is new, the edges are very sharp (Figure 61c). 
This bite mark type rarely overlaps with other excavator bite marks. The annotator counts the 
number of excavator bites per coral species per condition category per quadrat. It is most common 
on Porites compressa (Figure 61 c-d). However, keep in mind that P. compressa branches break 
off easily with disturbance, so look around the colony for broken branches before marking as an 
excavator bite mark. This coral species also tends to have pale branch tips, either as a result of a 
healing excavator bite mark or due to a broken branch tip. In this case, only count as an excavator 
bite mark if the top of the branch is clearly flattened with rounded edges and there are no broken 
branches in the vicinity; these would be considered to be in “healing” condition (Figure 61d). 
Massive Porites (Figure 61g), Pocillopora meandrina (Figure 61f), and Pocillopora grandis 
branch tips also experience excavator bites. Excavator bite marks on Pocillopora species are 
usually very large (the whole branch tip is removed) without defined margins along the branch tip 
edge. Because it can be nearly impossible to determine whether these represent more than one bite 
mark, count as a single bite mark and consider increasing the overlap score (Figure 61f). Excavator 
bite marks are less common on Montipora capitata (Figure 61e) and Montipora patula, but will 
appear as big chunks of bare white skeleton with clearly defined edges. 
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Figure 61. (A) Barred filefish (Photo by Reef Life Survey) and (B) spotted pufferfish (Photo by 
Wikipedia Commons). Excavator bite marks on Porites compressa, (C) new and (D) healing. 
Examples of excavator bite marks on (E) Montipora capitata, (F) Pocillopora meandrina and (G) 
massive Porites. 
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6. Scraper (SCRAP) 

Scraper bite marks are also caused by the barred filefish (Cantherhines dumerilii) (Figure 61a) and 
the Spotted Pufferfish (Arothron meleagris) (Figure 61b). Bite marks for these two fishes are 
grouped under the “SCRAP” category because of their similarity. Scraper marks can be very 
similar to excavator marks; the main difference is the depth of the resulting bite wound. Scraper 
marks are shallower “nips” or “nibbles,” less than 0.3 cm deep, that expose coral skeleton (Figure 
62). As opposed to an individual parrotfish bite mark which has one pair of marks (one from their 
upper mouth beak on the top and one from the lower beak), scraper bite marks have two pairs of 
bite marks (two on the upper portion and two on the lower portion). However, the two pairs of bite 
marks are only visible on coral species with flat surfaces, such as massive Porites, and will appear 
as “nibbles” on other species, such as Pocillopora meandrina (Figure 62a). This is because the 
upper and lower teeth of the filefish and pufferfish are not fused like the beaks of parrotfish. The 
annotator counts the number of scraper bites per coral species per condition category per quadrat. 
Scraper bite marks are most common on Pocillopora meandrina branch tips. As with the excavator 
bite marks on this coral species, whole or large swaths of branch tips might appear to be missing 
without clear boundaries between bite marks. In that case, count as one bite mark and increase the 
overlap score. Pocillopora meandrina sometimes has very pale tips which may not necessarily be 
indicative of a healing bite mark. This is a fast growing coral species, and it may take time for 
Symbiodinium, a single celled algae that lives within coral tissue, to colonize the branch tips. In 
cases of pale branch tips, only count as scraper marks if the verrucose (the bumpy projections on 
the branch tips) are missing and consider these marks to be in “healing” condition (Figure 62b). 
This bite mark type is also seen on the massive Porites colonies and Porites compressa (Figure 
62c). Scraper bite marks can sometimes be found on Montipora patula (Figure 62d) and Montipora 
capitata and will similarly look like a shallow bite mark with exposed skeleton. These are not to 
be confused with tube worm holes, which can expose a little bit of white skeleton, but have a black 
hole in the middle. 
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Figure 62. (A) Scattered scraper bite marks on the branches of Pocillopora meandrina. (B) Different 
conditions of scraper bite marks on Pocillopora meandrina (blue box is a healing scraper mark with 
a light tip and some verrucose missing, green box is a new scraper bite mark, and red box is not a 
bite mark as it is a light branch tip without missing verrucose). Scraper bite marks on (C) Porites 
compressa and (D) Montipora patula. 

Bite mark condition 

When these surveys were developed, it was difficult to determine which bite marks to count since 
they could be at different stages in the healing process. In order to be comprehensive and eliminate 
the need for annotators to decide which marks to quantify, it was decided that all bite marks should 
be included and assigned a condition score. Differentiating among conditions will provide useful 
information. For example, areas may be identified that have corals with high healing potential, are 
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unable to recover from corallivory, or repeatedly exhibit new corallivory marks across multiple 
surveys. Different condition types will apply to some corallivory categories more than others due 
to the extent of damage imposed by different corallivores and the nature of wound recovery for 
different bite marks.  

1. New (NE) 
Bite marks categorized as “NE” are injuries that have been recently inflicted (days to weeks). For 
bite mark categories that include skeleton removal (SCSP, EXCAV, SCRAP), the skeleton is 
exposed and bright white, no polyps or algae growth is visible, and the bite mark edges are sharp 
(Figure 63a-b). For bite mark categories that only include polyp removal (EXBR, DRUP, STAR), 
the skeleton will look bright white with little to no algae present and without any polyps 
recolonizing the wound (Figure 63c-d). This category is common for EXCAV, SCRAP, DRUP, 
and STAR bite mark categories. 

 
Figure 63. Examples of new bite marks across different bite mark categories and coral species. (A) 
Excavator on massive Porites, (B) scraper on Montipora patula, (C) Drupella on Porites compressa, 
(and D) sea star on Pocillopora meandrina. 
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2. Healing (HE) 
Bite marks in this category were likely inflicted a few weeks before the survey was conducted and 
have had some time to heal. For bite mark categories that include skeleton removal (SCSP, 
EXCAV, SCRAP), the area will look pale compared to the rest of the colony, some polyps will be 
visible albeit usually still clear, parts of the skeleton will still be missing, and the edges of the bite 
marks will appear dull. For example, the top of the branch of Porites compressa will appear pale, 
flat and with rounded edges (Figure 64a). For scraper and excavator bite marks on Pocillopora 
meandrina, only mark as a healing corallivory bite mark if part of the skeleton and/or verrucose 
are missing (Figure 64b). The branch tips of Porites compressa and Pocillopora meandrina can 
often look pale, but only count as a healing bite mark if part of the skeleton is missing and it 
appears somewhat flattened. For bite mark categories that only include polyp removal (EXBR, 
DRUP, STAR), the bite mark will look paler than the rest of the colony, but polyps will be visible, 
although these might still look transparent (Figure 64c-d). Healing bite marks are uncommon with 
DRUP and STAR because these types of predation are often either extensive, preventing recovery, 
or they lead to complete colony mortality. This category is common for SCSP, EXCAV, SCRAP, 
and EXBR bite mark categories. 

 
Figure 64. Examples of healing bite marks across different bite mark categories and coral species. 
(A) Excavator on Porites compressa, (B) scraper on Pocillopora meandrina, (C) blenny bites on 
massive Porites, and (D) parrotfish on massive Porites. 
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3. Old (OL) 
Bite marks that are categorized as “OL” are probably weeks to months old. They have been 
covered with turf algae, or in some cases little “tufts” of cyanobacteria, but the identity of the scar 
underlying the algae is still recognizable. For bite mark categories that include skeleton removal 
(SCSP, EXCAV, SCRAP), the injury can look similar to a new or healing bite mark but will have 
medium to large tufts of algae growing on the wound (Figure 65a). This condition is not common 
among EXBR bite marks because they usually fully heal. DRUP and STAR bite marks may start 
to be colonized by large amounts of turf algae (Figure 65b). This category is most common with 
the EXCAV bite mark category. 

Figure 65. Examples of old bite marks across different bite mark categories and coral species. (A) 
An excavator bite wound on Porites compressa and (B) Drupella bite wound on Montipora capitata. 

Overlap scores 

There can be high levels of overlap between bite marks, especially with some of the categories 
such as EXBR and SCSP. The higher the overlap, the more difficult it is to accurately estimate the 
number of bite marks. Therefore, overlap scores are assigned in order to estimate how much 
corallivory may be undercounted. For example, the higher the overlap, the more likely corallivory 
is being undercounted because of the difficulty in distinguishing individual bite marks. 
Additionally, overlap scores help determine whether focused predation is occurring. When 
annotating, the overlap score is a rough average per coral species per bite mark category per 
condition category per quadrat. Keep in mind that colonies with few bite marks can have high 
overlap scores and colonies with many bite marks can have low overlap scores. Overlap is assumed 
any time multiple bite marks are touching. For example, EXBR bites may consist of two circles 
overlapping with each other or a large white area with only a few distinguishable circular shapes. 
Overlap scores are not assigned to DRUP and STAR predation because they leave behind large 
swaths of coral rather than inflicting multiple bite wounds. There are four overlap scores: 

● Score 1: < 25% of bite marks overlap. These bite marks are easy to count as they are spaced 
out and have easily distinguishable edges (Figure 66 a, e, and i). 
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● Score 2: 26–50% of bite marks overlap. With this score, it becomes more difficult to count 
the number of bite marks individually, but it should still be possible to see a lot of bite 
marks edges (Figure 66 b, f, and j). 

● Score 3: 51%–75% of bite marks overlap. With this score, it is likely that the number of 
bite marks will need to be estimated based on the size of individual bite marks and the 
extent of predation on the colony. This score is common for SCSP and EXBR bite mark 
categories and can also be common with SCRAP and EXCAV bite mark categories on the 
branch tips of Pocillopora meandrina. For example, when there are wounds that are large 
and cover the whole branch tip, count as one bite mark and increase the overlap score to 
account for the likely possibility that the wound is made up of more than one bite mark 
(Figure 66 c, g, and k). 

● Score 4: 76%–100% of bite marks overlap. These bite marks are similar to category three 
but will appear as a large white mass of bite marks with hard to see edges, whereas category 
three the bite marks will be more spaced out. Similar to category three, this score is most 
common with SCSP and EXBR corallivory categories and with SCRAP and EXCAV 
categories on Pocillopora meandrina branch tips (Figure 66 d, h, and l). 
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Figure 66. Examples of different overlap scores for (A-D) SCSP, (E-H) EXBR, and (I-L) SCRAP bite 
mark categories. Numbers on the bottom left corner of each image represent the overlap score. 
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Appendix 2. Extracting orthoblocks  

After the orthomoasic is generated, the full mosaic can be divided into smaller chunks to be used 
for downstream image analysis. These chunks, henceforth referred to as “orthoblocks,” capture the 
precise area of a quadrat, taken from a 2D orthomosaic and exported from ArcGIS Pro as a .PNG 
file to maintain high resolution. Orthoblocks, similar to photoquadrats, can be uploaded to 
CoralNet and annotated to determine percent benthic composition by coral species or substrate 
category.  

Generating high-resolution orthomosaics in Agisoft: 
If a project requires high-resolution orthomosaics, the most efficient process consists of building 
the original orthomosaics (section 3.3) at the default resolution and exporting two TIFF files (.tif) 
at higher resolutions (e.g., 1mm/pix and default mm/pix). 

If only a low-resolution orthomosaic has been built: 
1. Open the Agisoft file for the project (e.g., 

M:\Corallivory_MHI\HAN3\Products\HAN3.psx). 
2. In the workspace, double click on the current orthomosaic (Figure 67). 
3. Right click on the orthomosaic in the workspace and deselect ‘Set as Default’ (Figure 

67). 

 
Figure 67. (1) Double click on the current orthomosaic, then right click and (2) deselect the ‘Set as 
Default’ option. 

4. To build the high resolution orthomosaic go to ‘Workflow’ → ‘Build Orthomosaic’ and 
run using the default resolution (i.e., leave the ‘Pixel (m)’ setting to the default numbers). 

5. Once complete, re-export the high resolution orthomosaic using the default resolution. 
a. Refer to step 7, section 3.1E of the SfM SOP. 
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Extracting PNGs for each quadrat in ArcGIS Pro: 
1. Open the ArcGIS Pro file for the project (e.g., 

M:\Corallivory_MHI\HAN3\Products\ARC\HAN3\HAN3.aprx). 
2. Deselect all layers in the contents pane except for the segments (i.e., the outlines of the 

quadrats) (Figure 68). 

 
Figure 68. On the left contents pane, deselect the multipoint tool, transect lines, and orthomosaic 
tiff; leave only the quadrat outlines selected. 

3. Import the high-resolution orthomosaic:  
a. ‘Map’ → ‘Add Data’ → Navigate to the high resolution ortho → ‘OK’ (Figure 

69a). 
b. The ortho will not automatically appear, but it is loaded once the TIFF file shows 

up in the contents pane. (Figure 69b). 
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Figure 69. (A) (1) Go to the ‘Map’ tab, (2) select ‘Add Data,’ (3) navigate to the high resolution 
ortho, and (4) select ‘OK.’ (B) Once uploaded, the high resolution tiff will appear in the navigation 
pane. 

4. Georeference the high-resolution orthomosaic (Figure 70). 
a. ‘Analysis’ → ‘Tools’ → ‘Define Projection’. 

i. Input dataset: High resolution orthomosaic (SITE#_orthomosaic_hr.tif). 
ii. Coordinate System: WGS 1984 UTM Zone 4N. 

iii. ‘Run’. 

 
Figure 70. (1) From the ‘Analysis’ tab, (2) select ‘Tools.’ Search for and select ‘Define Projection’ 
(not pictured). (3) In the ‘Define Projection’ pane, fill in the ‘Input Dataset’ and ‘Coordinate 
System’ fields as described above and select ‘Run’. 
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5. The coloration of the ortho will be off and will need to be corrected under the ‘Raster 
Layer’ tab. 

a. Make sure the high resolution TIFF is selected on the left side pane. Then go to 
‘Raster Layer’ → ‘Stretch Type’ → ‘None’ (Figure 71). 

 
Figure 71. With the high resolution TIFF selected on the left pane, (1) go to the ‘Raster Layer’ tab, 
(2) select ‘Stretch Type’ and then ‘None’ from the drop down menu. 

6. Click on the first segment overlaying the orthomosaic by using the ‘Select’ tool under the 
‘Map’ tab (Figure 72).  
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Figure 72. (1) Select the ‘Map’ tab, (2) then click on the ‘Select’ tool, and (3) lastly click on the first 
segment. 

7. In the Geoprocessing pane (go to ‘Analysis’ tab → ‘Tools’), search for ‘Clip Raster’ and 
fill in the fields as follows (Figure 73): 

a. Input Raster: SITE#_orthomosaic_hr.tif 
b. Output Extent: SITE#_segments  
c. Check ‘Use Input Features for Clipping Geometry’ 
d. Output Raster Dataset: Rename to SITE#_Q1 → ‘Save’ 
e. ‘Run’ 
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Figure 73. Fill in the fields in the ‘Clip Raster’ pane as indicated and select ‘Run’. 

8. Repeat step 7 for the remaining segments (i.e., quadrats) by selecting each segment and 
renaming the ‘Output Raster Dataset’ to the appropriate quadrat number (i.e., Q#). This 
will create a ‘Raster Layer’ on the left pane for each segment. 

9. All new raster layers will be discolored. Individually select each raster layer in the 
contents pane (on the left) and navigate to ‘Raster Layer’ → ‘Stretch Type’ → ‘None’ 
(Figure 74). 

 
Figure 74. For all the layers, (1) select the raster layer on the left pane, (2) go to the ‘Raster Layer’ 
tab, (3) select ‘Stretch Type,’ and (4) click on ‘None.’ 
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10. To export a .PNG of each raster, right click on the raster layer (i.e., HAN3_Q1) in the 
contents pane (on the left) → ‘Data’ → ‘Export Raster’ (Figure 75). 

a. Output Raster Dataset: Navigate to the site’s orthoblocks folder (i.e., 
M:\Corallivory_MHI\HAN-3\Products\ARC\orthoblocks) and save as 
SITE#_Q#.png 

b. Leave all other fields as default, but double check that the Output Format is PNG. 

 
Figure 75. Right click on the raster layer, select ‘Data,’ and click on ‘Export Raster.’ Fill in the pop 
up window as described in step 10. 

Orienting the PNG and converting to JPG with photo editing software: 
1. Individually open each PNG with an editing software (e.g., Paint3D). 
2. If using Paint3D (Figure 76): 

a. Use the select tool and highlight the whole quadrat. 
b. Rotate the image until it is squared with the computer screen. 
c. Using the crop tool, crop out the extra gray space around the quadrat. 
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Figure 76. Open the PNG of the quadrat in Paint3D, (1) click on the ‘Select’ tool, (2) use it to 
highlight the whole quadrat, (3) rotate until the quadrat is square with the screen, (4) and select 
‘Crop.’ 

3. Save the rotated and cropped photoquadrat as a JPG in a new ‘Photoquads’ folder: 
a. e.g., M:\Corallivory_MHI\HAN-3\Products\Photoquads 
b. Save as SITE#_Q# 
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